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ColorMunki – Have your photos submitted for QuickPix, Members‘ Night, or competitions not looked the way you 

expected? The problem is probably a difference in how your computer and the club projector display colors and 

brightness. You can fix this by calibrating your computer the same way our club calibrates our projector – with the 

ColorMunki. Set up is simple and the calibration process only takes a few minutes. Contact Carl Detrow at 

csdetrow@verizon.net  to reserve the ColorMunki.  
__________________________________________________________________________________________ 

 

Puppy and Kitty Portraits Help Shelter Pets Find New Homes  
 

 
 

RCC Member Debra Dorothy helps shelter pets find new homes by taking 
portraits of them. The photos of these furry creatures were taken at the 

Redlands Animal Shelter. If you would like to adopt an animal please call 
the Redlands Animal Shelter at 

(909) 798-7644 

 
Want to learn more about your hobby?  

Click the link below to go to B&H learning Video Site:  Click HERE 

 

mailto:csdetrow@verizon.net
https://www.bhphotovideo.com/c/promotion/13486/optic-2017.html?utm_medium=Email%201654964&utm_campaign=Promotion&utm_source=WeeklySpecials%20170916&utm_content=Retail&utm_term=optic-2017


Field Trips – Mary Ann Ponder  
  

 November Field Trip 
Coachella Valley 

 

This month the club outing is a road trip to the Coachella Valley on Thursday, 

November 7th.  

 

We will visit the desert communities of Morongo Valley, Yucca Valley and 

Joshua Tree. Stop for photos at Noah‘s outdoor art museum and Cabot‘s 

Pueblo Museum.  

 

Lunch at the Casa Blanca Mexican Restaurant in Desert Hot Springs or bring your own. Even shoot some 

windmills if time allows.  

 

Return to Redlands in the afternoon. 

 

Please sign up at least one day in advance for this outing by contacting Mary Ann Ponder at 909-213-

5108 or e-mail maponder@yahoo.com. Monthly field trips are a benefit of RCC membership. There is no 

charge to members but sign-ups are required.  

 

A carpool will depart at 8:30AM from Coco‘s Restaurant, 1140 West Colton Avenue in Redlands. We meet 

up at the back of the parking lot and return to this location at the end of the field trip.  

 
 
 

 

Photo 
By 

Mary Ann Ponder
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Competition Chair – Carl Detrow 

Competitions 

 

Winter Competition Entries Start November 4 

 

Our next competition will be Winter 2019 on December 2 with awards to be 

presented at our holiday celebration on December 16.  

 

Category X Will be ―Smart Devices.‖ The image may be in any category and may be 

post-processed as you would any other competition image. The only requirement is 

that each entry must be originally captured by the member on a digital device such as a smart phone or 

tablet.  

 

Other categories are People, Places, Animal, Photojournalism, Closeup, and Open/Miscellaneous.  

 

Up to two entries per member will be accepted on the website November 4-18. The entry form will be 

taken down at 11:00 PM, November 18. Entry fee to cover awards, equipment, and judges honoraria will 

be $10.00 for one or two entries. 

 

Images must be JPG, no more than 4000 pixels on the long side, sRGB color space, and may not exceed 

3.5 MB.  

 

Be sure to have a title and filename available before you start the entry process. See the website for 

information on the differences between titles and filenames. Shorter titles are preferred so that they can 

fit on your ribbon when you win one. 

 

Good shooting and good luck! 

 

Contact me by email:  csdetrow@verizon.net 
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President’s Message – Dave Ficke 
 

Dear Redlands Camera Club Members 

  

I have been recently thinking about the ethics wildlife and landscape 

photographers adhere to in their work.  Just as I studied the subject of 

ethics when I was earning a Masters degree in Environmental Education, I 

must consider what is appropriate and standard across the field of wildlife 

and landscape photography. Questions to consider could be what is 

acceptable in digital manipulation?  Is it okay to add objects, birds, moon 

and clouds, change backgrounds or remove objects? What is of critical 

importance in wildlife and landscape photography?  Is it the story itself or 

one‘s ability as a photo illustrator to alter an image so it ―looks‖ better?   

  

Redlands Camera Club has no posted standards for our competitions.  If there is no guideline for a 

specific category, it‘s like having no target for archery practice; you will miss it every time!   With no 

guidelines how does anyone know what is acceptable and what is not? How will the judges know 

either?  We need RCC members to help us fix this.  We need your feedback, and we need it soon.  

  

I thought that it would be good if I did some research just to help me define my own personal ethics 

in regards to wildlife and landscape photography.  So I did a Google search of the top wildlife and 

landscape photographers of the world and from that list I sent everyone a separate letter asking the 

following: ―I would like your input regarding standards or guidelines for the category of landscape 

and wildlife photography, what constitutes a ―real‖ image, and what would be described as an 

artistic representation of an image.  Their very conclusive and articulate responses, most coming via 

email response follow below:  

  

Tim Man Lee – ―Some readers recently told me they are new to photography and asked me how to 

define art in wildlife photography because they are confused when seeing people adding stuff to 

beautify their wildlife and landscape photos.  I'm very strict to myself in not adding any fake stuff in 

my photos‖. https://tinmanlee.com/element4/ 

  

Karina Aigner – ―Super short answer, if 'adding a moon' means digitally altering a frame that was not 

photographed with a moon, and you are passing it off as true nature photography and yourself as a 

true nature photographer...no, that is not how we do things and yes it is 'wrong,' but,  with the caveat 

that you are positioning yourself as a true nature/wildlife photographer.  It's not wrong if you are 

open about the fact that your images are photo illustrations and you are creating 'fine art 

illustrations' so to speak.  Again, it comes down to what kind of a photographer you want to be.‖ 

  

Jen Guyton – ―I would not ever think it's legitimate to swap backgrounds or add a bird or clouds, as 

those improvements are something that can be earned through time and persistence behind the 

camera. Adding them in post-processing is cheating, plain and simple, and your work and reputation 

would suffer for doing it.‖ 

https://tinmanlee.com/element4/


 

  

Dave Welling – ―First, and foremost, I would say that camera club competitions require an image to 

be natural in its elements and composition - no adding clouds or another baby cheetah to make it 

"artistic". Camera club competitions are about PHOTOGRAPHY, not about creating ‗art‘ by 

adding things- that takes the image out of the realm of photography and puts it into graphic artistry 

- a completely different discipline.  

 

All those who suggest adding clouds miss this basic point and/or do not understand what 

photography is and should be about.  

 

What true landscape (and wildlife) photographers do to ‗create an image‘ while adhering to the 

above basic ground rule is to use lighting and composition to frame the image and then apply the 

most important element of all - Patience. You wait for the just the right moment when the light 

changes to that dramatic, golden light or the animal finally walks into the scene at the waterhole. (I 

spent nine hours in a non-breathable blind one day in South Texas (it was 95 degrees and 90% 

humidity) waiting at a waterhole for white-tail deer to come to drink. When they finally came in a 

group of four I captured one of my best images of whitetails I have ever taken. The creative part 

involved waiting for the moment, not adding something that was not there.‖ 

  

Tom Dyring – Tom is from Norway and apologizes for his English ―Your question is pretty complex 

as it apparently (as I understand it) involves different photographic categories & situations. When 

you`re working with nature photography and your fellow photographers advice (sic) you to «add a 

bird or a moon or a cloud» for a more artistic approach I would certainly understand this to be shot 

in the same frame. To add «bird or a moon» from another picture is in my ethic standard an 

absolute «taboo».  

 

All international photo contests that involves nature photo or press photo have strict rules about not 

adding or altering ANYTHING in the picture except adjustment of light, blacks, whites, color etc. that 

applies to the whole frame.‖ 

  

Any Gulick – ―For me, I want to know if what I am looking at is authentic or not. If the photographer 

added elements to or deleted elements from an original capture, I want to know about it. When 

someone passes something off as ―real,‖ and I find out that it‘s not, I feel duped. And no one likes 

feeling duped. The problem is that many photographers add/delete elements and don‘t disclose this 

in a caption to the photograph. This is disingenuous and does a disservice to both the photographer 

and viewer. There are contest categories, though, that allow for this kind of manipulation and they 

tend to be described as ‗Photo Illustration‘ or ‗Creative Art,‘ etc. These categories are defined in a 

way that lets the viewer know that he/she is clearly looking at a manipulated photograph. I think 

these kinds of images are fine as long as a caption makes clear what we‘re looking at.‖ 

  

Windy Shrittil – Windy, who is from North American Nature Photography Association (NANPA), and I 

had a great telephone conversation, and she made a comment indicating that if you are a true 

wildlife or landscape photographer, you keep true to that and if you want to add or subtract items, 

then you enter your image in a different category.   



 

  

George Lepp – In a telephone conversation Mr. Lepp observed that he liked to use the word 

‗optimization‘ as opposed to ‗manipulation.‘  Mr. Lepp was very clear that adding objects to an 

image is not acceptable unless it is identified as an illustration.  Removing a ‗distracting‘ object that 

does not take away from the photograph‘s story is appropriate.  Mr. Lepp also pointed out that a 

photographer must read and follow the directions of each competition so he or she has a clear 

understanding of what is or is not acceptable.  He pointed out that focus stacking and panoramas 

are not acceptable in the Wildlife Photographer of the Year Competition while in other competitions 

it is allowed.  Overall he agrees that adding birds or a moon or other objects in your photography is 

not allowed unless you identify it as ―illustration‖.   

  

Tom Mangelson – I had the privilege to speak with Bill Allen, retired editor in chief of National 

Geographic, and now assistant to the photographer on Mangelson‘s website. ―In an age of rampant 

digital manipulation of imagery and an era in which many nature photographers take shortcuts to 

amass portfolios by frequenting ‗game farms‘—facilities that rent out wildlife ‗models‘ by the hour—

Mangelsen‘s work stands as a striking and noble counterpoint.‖ Allen says. 

  

Every single image in Mangelsen‘s portfolio has been taken in the wild under natural conditions, the 

result of him waiting for the ―picture perfect moment‖ across decades and often in hostile 

conditions. Such a body of work can only be achieved by having a heightened sense of animal 

behavior, an uncanny feel for being able to read changing atmospherics in the environment, and 

patience. 

At a time when digital technology is, notoriously, reprogramming its users to have shorter attention 

spans, A LIFE IN THE WILD, Mr. Mangelsen‘s outstanding latest collection of wildlife photographs, 

stands as a testament to the rewards that can come to people who slow down their lives and wait 

for nature‘s revelations to happen. 

At RCC, there are no standards for the categories ―places‖ and ―animals.‖  There are no guidelines or 

boundaries, and digital manipulation is allowed in both of those categories.   Some say that as an 

―artist‖ you are free to create whatever you want.   

Although I completely agree with this, I also believe we need to have two more categories that 

preserve the ethics of true wildlife and landscape photography as described by the input from these 

well known, celebrated professionals who call themselves true wildlife and landscape 

photographers.  Digital art, illustration, manipulation-- creative art should be placed in a separate 

category.  In this way we can preserve, what is ―real‖ and ―fake or altered‖ and hold in high esteem 

those who spend hours or days to get that perfect shot.  

At this point the competition committee is reluctant to consider any kind of compromise by adding 

the two categories.  Currently IEPPV, PSA, PPA and NANPA all have separate categories for 

landscape and illustrative landscape as well as wildlife and illustrative wildlife.   Reply to this article by 

emailing either Carl Detrow, Chair of Competitions at csdetrow@verizon.net or myself 

at yosemitedave1@hotmail.com or both of us. This is your club and we need to hear from you as to 

your opinion on this issue and what you want. Please.  

mailto:csdetrow@verizon.net
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Program Chair- Russell Trozera  

 

Nov. 4th Video 101 with Bradley Toms 

 

I‘ve been doing camera work for almost 8 years, 

and filming weddings for a little over 6. I went to 

school for communications and specialized in 

advertising which lead me to getting my foot in 

the door for an ad agency as a freelancer. I 

worked there for about a year, and now film 

different projects for companies like Acorns, LPA, and healthcare 

clients. Photographing weddings is my full-time gig, and the 

freelance work is just to keep me busy during the week. Besides 

doing video, I love traveling, and taking photos of those travels is 

what I would consider my hobby. While taking photos can make me 

money, I prefer to keep it as my hobby.  

 
 
Nov. 17 Drone Photography for Fun & Profit with Gary Jefferson & Russ 

Trozera  

 

I've done many things in my life, but photography has been the most fun. I took my first photos in the 

80‘s, got serious in the 90‘s, shot for a stock agency in the early 2000‘s and then retired in 2012 so I could 

take more photos. I enjoy shooting and developing film but most 

of my images are taken with a digital camera. I have been flying 

drones since the original DJI Phantom came out in 2013. I 

photograph mostly people now (Redlands People), but use the 

drone often when we travel. I‘ve flown in many states and in 

National Parks - when it was legal to do that. In the beginning, it 

took me more than three years to take a photograph that I 

thought was good. It took about the same time to do the same 

thing when I began drone photography.  

 

 

 
Russell Trozera is an accomplished photographer and is certified by the 

FAA under Part 107 as a drone pilot. He has logged 132 flights or about 

60 hours of flight time. His primary use of a drone is in real estate, 

getting a better view from above. His love for photography began in 

college. He took a break when raising 5 children. His love for 

photography was reignited when he bought his first digital camera in 

1997. It was not so expensive and he did not have to mess with all the 

chemicals. 



 

S4C Chair – Deborah Seibly 

 
 

Results from the First S4C Competition of this Year 
 

Two members from the Redlands Camera Club received Honorable Mentions 

for their images in the opening competition of the S4C Competition Year 

2019-2020. 

 

Christine Cope Pence received an HM for her image ―Moody Spokane‖ in the 

Individual Color category (level E) and another for her photo ―Port Townsend 

Graffiti‖ in the category Photo Travel (level A  

 

Clay Hodson received an HM for his photo of a black bear entitled ―Don‘t Run‖ in the Nature Wildlife 

category.  

 

Congratulations to our camera club members. The current competition opened on Oct. 21 and will close 

at end of day on Nov. 2. Although judged remotely prior to meeting, the results will be presented live at 

the University of Redlands on Nov. 9th. Anyone is welcome to attend. 

 

I encourage club members to enter the S4C competitions. These competitions offer something for 

everyone as some categories emphasize your creative skills and others emphasize camera skills. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
  

 

 

 

 



 

Here’s What I Think! 

 

This article covers different Adobe Photoshop/Lightroomtips 

and techniques.  The views expressed in this article are those 

of the author and do not necessarily reflect the views of 

Redlands Camera Club. 

By John Williams 

 
Need help?  If you have any questions about processing an image using Adobe Lightroom or Photoshop, email 

me at jhwr@earthlink.net (for RCC members only) and I will try to assist you.  

PHOTOSHOP TIPS 

Adding Guides: 

1. First method:  Turn on the rulers (Ctrl+R) and drag a guide 

from either the top of left ruler.  The guide will snap to the 

center of the image while dragging. 

2. Second method:  Choose View>New Guide Layout.  In the 

popup dialog set the number of columns and Rows.  Make 

sure the Gutter field is empty (set to 0).  Click OK.  You can 

record the steps as an action to make it nearly 

instantaneous. 

Working with Masks: 

 Move masks to another layer:  If you have created a mask 

and want to move it to another layer (such as an 

Adjustment Layer), hold down the Alt key and move it to 

another layer.  If you want to invert the Mask, then hold 

down the Shift and Alt keys when moving the mask. 

 Combining existing masks into one mask:   First select one mask and Ctrl-click on the mask.  The areas in 

white will be selected.  Then on another mask, hold down the Shift key and Ctrl-click on the mask.  This will 

add the selection of the second mask to the first selection.  Finally add an Adjustment Layer and the 

attached mask will have the combined white areas of the two mask.  

Resize and scale areas of your photo when taking wide angle landscapes photos: 

 When you take photos using a wide-angle lens, nearby element will be larger and background elements 

will be smaller as seen real life.  This technique will enlarge/transform your background elements.  

 First you will make a loose selection around a background element, normally with the Lasso Tool.   

 Then choose Select>Modify>Feather and feather 25-pixels.  This will soften the edges. 

 Duplicate the selection (Ctrl+J) which will place the selection on its own layer.  

 Free Transform the selection (Ctrl+T).  Enlarge the selection and move it over the image so it aligns 

correctly. 

 To hide the transition lines, select the Eraser Tool:  Make sure you use a large diameter soft brush 

(hardness 0%) and use the edge of the brush to erase.  Sometimes lowering the Eraser Opacity will help 

when erasing (Options bar: Opacity set to 60%). 

 To make the image look better, you may need to use the Clone Stamp tool.  

 Example:  In the image below, a selection was make around the far distance mountains and transformed 

larger. 

mailto:jhwr@earthlink.net


 

 
BEFORE                                                                                          AFTER 

LIGHTROOM TIPS 

Double-dot Lightroom Update releases: 

 Double-dot update releases only contain bug fixes and new camera support.  They do not contain new 

features. 

 Determine version number:  Launch the Adobe Creative Cloud app on your desktop and hover your cursor 

over the name of the program (see figure below).  The version number will automatically show as seen in the 

figure below. 

 
Moving Your Lightroom Classic Edits from your Laptop to your Home Desktop Computer: 

 If you took photos while traveling and edited them on your Laptop computer, you may want to have all 

yours edits transferred to your home desktop (main) computer.  

 The process to transfer your edits follows:  

1. Create a Collection with all your travel photos (this allows you to place photos from different Folders).  

2. Right-click on the name of the Collection.  The following popup menu will display:  

 
In the popup menu, choose Export this Collection Set as a Catalog. 

NOTE:  If you work in Folders, rather than Collections, it would say Export this Folder as a Catalog. 



 

3. The Export as Catalog dialog will pop up giving you 

the option where to save the exported catalog file.  

Normally you will want to save it to an external 

hard/USB flash drive or a storage service such as 

Dropbox or iCloud.  Name the file and depress the 

Save button.  At the bottom of the popup window 

are checkboxes for some options and the most 

important one is Export negative files.  By checking 

this box,  a copy of your actual images not just 

your thumbnail previews will be exported.  Nothing 

about this process will change anything in your 

original catalog. 

4. Eject your USB flash/external drive from your laptop 

computer and plug it into your home computer.  

5. In the Lightroom Classic Folder panel, add a new 

folder where you want the photos to be placed, if 

necessary. 

6. In the Lightroom menu bar (home computer), 

choose File>Import from Another Catalog.  This will launch the Import from Lightroom Catalog window 

(see figure below) and select the .Ircat file (not the Previews, or Photos folders) on the external/UAB drive 

and click Choose button. 

 

7. Once you click the Choose button, you will see a menu of options to select from as shown in the image 

below. Slowly go through each option, making sure you are happy with your choices.  Select the Copy 

new photos to a new location and import  option and choose the file location. (red box in diagram below).  

Depress the Import button to add the photos with lightroom adjustment to your master catalog.  

 
 

 

 



 

RCC Photo Blog – Stan Fry 
 

Redlands Camera Club Group Members Only 

Are you a member of the Redlands Camera Club? Come and join our new 

Members Only group where you can share images, tips, tricks, offer support or 

insights, ask questions and interact with other members without all the other 

distractions of an open group. Please read the rules and you must be a 

Redlands Camera Club member to join!  

We are up to 70 users and almost 1,100 images on the RCC Photo Blog.  

If you do not already have an account,send an e-mail to signup@rccphotoblog.com and we will get you set up. 

The blog is a great place to get input on your images. Other Members‘ images can help you find some inspiration 

(and perhaps some motivation). 

We are working on the image color issue for some images.  When images are submitted they are resized to fit 

different screens.  In this process, they are desaturated a bit.  We don‘t know the cause of the problem yet, but are 

working on a solution. 

 

I got tired of sifting through photography sites and blogs trying to find useful learning material.  In response, I 

created pbdigest.com – a curated (sort of) collection of photography articles from over 100 photography blogs.  

Given that this site helps me keep track of useful learning resources, I though club members may benefit too.  I 

would also be interested in any feedback you might have.  Thanks for taking a look and I hope the site is helpful to 

you.  

 

 

 

 

 

 

 

 
Photo 

By 
Mary Grossman 

 

 

 

 

 

https://www.facebook.com/groups/2521924061368053/?__xts__%5B0%5D=68.ARCMAALkoRBiKV1gSiQlz6tIFwP9hhA0vDx7b_cNQPtCWsrnFMzm43yvMG4XGCLGF8UwN6ingQLl8pIRVLlFRKC-t81BV15gmBA8fWuptNsT85AI8BJu5BBvlHdKIOPq2ehadlUiqXAE25HwAqNDrKmKcreKuQkyCDhfU2Um_PIjoNfzm-yMmxlb27M_n1MbD0VOrODP5y4kS-ZhpNbY2LxPmu3_rYsXSOvN0WdeXQl7Q-2T7MzbQ_OLg2lLhCYKDuqHemuPluGDQDo-X5EDmnmwkePxpl6cQa4AZrRYCNuceCLnaXdyOfA-jhJQJgHljsQCnUyWfkuT29YQzMFPQQcc4w&__tn__=HH-R
http://www.pbdigest.com/


 

 
For Sale 

 

For Sale: New in Box Tascam DR-60D Digital Audio Recorder  

 

Want to greatly improve the audio quality of videos made with 

your DSLR, Mirrorless or other digital camera? Tascam, the 

professional division of Teac Audio, has your solution – the DR-

60D 4-channel audio recorder. Built to mount under your camera 

either on or off a tripod, this recorder offers 2 professional 

balanced XLR or ¼‖ TRS mic inputs plus a 3.5 mm stereo mic 

input. Its many modes allow you to capture very high-quality 

sound, tailor the sound to your preferences, and use microphones of widely different types. 

The LCD screen is fully visible in any lighting condition (even direct sunlight), and complete 

controls put you in charge of your recordings. In addition to its potential for recording audio 

for video, its many capabilities make it an excellent choice for any high-quality audio recording 

– music, voice you-name-it. Unit is in original box, has never been used, and comes with all 

included accessories. Sells on Amazon for $179; priced for quick sale at $119.  

 

Frank Peele, 909.798.7999, or email to FrankPeele@verizon.net. 

 
4 Photogenic Powerlight 1250 DR, with reflectors, flash tube protective covers, power cords, in 

carrying case: all 4 for $1200 with carrying case OR $350 each, carrying case $50 

[There are superficial marks where lights have rubbed against each other in carrying case] 

 

2Talon by Photogenic 13 ft air cushioned light stands, $60 each 

 

2 LumoPro 10 ft light stands, $20 each 

 

4 Aurora Lite Bank soft boxes with optional Photogenic speed rings:  

12 x 36: $40 or $70 with speed ring 

12 x 36: $40 or $70 with speed ring 

12 x 48: $50 or $80 with speed ring 

34 x 46: $80 or $110 with speed ring 

 

2PocketWizard Plus II transceivers with cords, in boxes with instructions, $120 set 

 

Gossen Luna Pro Digital F light meter, with strap, in pouch, with condensed instruction guide, 

$95 

 

12 x 12 Calumet heavy duty background stand in canvas carrying case, $90 

 

Westcott Illuminator Reflector 6-in-1 kit with arm, $90 

 

mailto:FrankPeele@verizon.net


 

PREFERENCE TO SELL COMPLETE STUDIO LIGHTING KIT ABOVE: $1800 

Please allow time to test all equipment before making this kit yours.  

All items in very good condition with low usage. 

 

Also: 

Variety of muslin backgrounds 

Beautiful wicker child-sized chaise-lounge prop 

Variety of small easels 

Variety of frames, 8 x 10 and larger, new in box and used 

 

Text Victoria: 909-735-1125 or email vwispell@gmail.com 

 
 

 

 

 
 

 

 

 

 

 

 

 

 
 

     

 

 

Photos By Judith Sparhawk 
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Announcements 
 

New – Personal Lightroom Coaching with John Williams 
 

Contact John Williams for some over-the-shoulder coaching in photo editing, a great way to learn. Using your 

selected images, John will work with you at your level to improve your understanding of key tools and techniques to 

make the most of your photos. John is a regular contributor of articles on Lightroom and Photoshop to the RCC 

Photogram. Reach John at jhwr@earthlink.net or talk to him at our meetings.  

 

RCC Members: Unique opportunity to make a difference 
Frank Peele, Education/Workshops Chair 

Museum of Redlands 

This newly-established museum needs quality photography of items in its collection, and has asked RCC for 

support. This sounds like a win-win situation, both for the museum and for our members who want to develop 

skills in ―product‖ photography. I envision a workshop to teach the fundamentals, and one or more shooting 

sessions to get into creating great images for the museum‘s use. If you‘re interested in being part of this service to 

the community, or just want to find out more about the opportunity, shoot me an email: 

educationworkshopsrcc@gmail.com  Thanks, Frank 

____________________________________________________________________________________________________________ 

Film cameras and Lenses Needed  
 
A group of photo-enthusiasts at Riverside Community College needs FILM cameras and lenses to use in their 

studies. If you have such equipment you‘re willing to donate to a worthy cause, please contact RCC member 

Constance St Jean and let her know what you have. Contact her by email at constancestjean@gmail.com 

 

_________________________________________________________________________________________________________ 

I will be giving a Bird Photography Program for the Coachella Valley Desert Camera Club on November 21st. If you 
wish to attend, the meeting is held at:   

 

The CVDCC club meets at the Portola Community Center: 45480 Portola Ave, Palm Desert, CA 92260. 

The meeting goes from 6:00 - 8:00p.m 

 

                                                                                                                                                                                                Debra Dorothy 
_________________________________________________________________________________________________________ 

 

Photographic Society of America Annual Conference: Spokane, WA 22-28 September 2019 

By  

Christine Pence 

 

This year‘s annual PSA conference started off with a week of pre-conference photography for me.  I took my 

brother-in-law on his first DSLR photographic journey ―off Auto‖ in which we wandered the Palouse of Eastern 

Washington looking for ghost sites, farms, rolling golden hills, waterfalls, wildlife, quaint downtown 1800s 

buildings, totem poles, monuments, dams, action from the past in a bordello museum, and so much more.  

 

The downtown area of Spokane is rich with photographic icons such as the United States Pavilion from Expo ‘74 in 

the Riverfront Park along the Centennial Trail which follows the meandering Spokane River through downtown. 

Sites are abundant including the historic Davenport Hotel, where you can still buy a new mattress and have it 

mailto:jhwr@earthlink.net
mailto:educationworkshopsrcc@gmail.com
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delivered; the Steam Plant brewery; the art deco Martin Woldson Theater (Bing Crosby, Frank Sinatra, Katherine 

Hepburn amongst many other famous names played there); St John‘s Cathedral and Cathedral of Our Lady of 

Lourdes; and so many more.  Foodies found satisfaction in a variety of epicurean fare even including La Presa 

Mexicana, a local hole in the wall spot on the outskirts of town.  

The PSA conference started with organized tours to the Palouse; the Duncan, Manito, and Nishinomiya Tsutakawa 

gardens; the Turnbull National Wildlife Refuge, the Burke ghost town in Idaho; a jaunt through Wallace, ID with its 

antique stores, museums, and historic old downtown buildings; an evening dinner and boat tour around Lake 

Coeur d‘Alene; and more locally an architectural tour of downtown Spokane.  

 

Wednesday through Saturday was filled with lectures, meet and greet meals, a few meetings, exhibitions, 

demonstrations, photo workshops, and of course the expo hall for purchases from top photographic suppliers. 

The final honors banquet ended with a short video on next year‘s conference to be held in Colorado Springs.  

Evening Keynote speakers throughout the week included Cole Thompson on ―Why Black and White?‖, Lewis 

Kemper on ―Expanding your creativity with time/motion techniques‖, and Nevada Wier on ―Creativity in Travel 

Photography.‖ The new organization this year meant I was able to attend events in all of the PSA divisions and 

learn from the many excellent speakers chosen by each division to speak on topics relevant to that division.  

 

My take away from this conference is that photography is a terrific medium for sharing life, experiences, 

knowledge, friendship, and creative projects. Photographers came from all over the world to participate in this 

conference and left with new ideas, new techniques, new visions, and lots of new friends. As a solo venturer, I 

found this group to be welcoming, inclusive, and really interested in assuring that I come away wi th a good 

experience and new friends. This certainly widened my horizons and circle of contacts for my next trips.  

____________________________________________________________ 
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Photogram Editor – Debra Dorothy 

A Note from The Photogram Editor 
 

The theme for the December‘s Photogram is ―Christmas‖.  Send me your best pix and I will 

include them in the next Photogram.  

 

mailto:debbiedsd.dorothy@gmail.com 
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